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Following information
1. The PCs in the student computer centre are standalone old 233 Mhz machines (PCs) with a maximum 64 MB of RAM running Windows ME.

2. The hard disk are IDE and the maximum capacity is 4 GB.

3. The PCs are equipped with just floppy drives.

4. The PCs have only serial and parallel ports with no USB or Firewire ports.

5. There is a single low speed dot-matrix printer, shared by all of the PCs, which is out of order most of the time.

6. They currently have no network.

7. There is a single dial-up internet connection shared by all the users who need to reserve it in advance.

1. The PCs in the student computer centre are standalone old 233 Mhz machines (PCs) with a maximum 64 MB of RAM running Windows ME.
The utilized CPU have 233 MHZ and it's mother board is equal to Pentium 2 mother board .Today, the Pentium 2 mother boards which are not widely used, because the Pentium 2 boards have the maximum size of CPU 233 MHZ, it can't use large program. It is impossible to load it. . If we want to use modernize device, should change the Mother board with Pentium 4 mother board and installed 2.0 Core 2 Dual to CPU. If all completed, it can found that the processing may be faster and quicker then before. If the memory has only 64 megabytes, the temporary storage space is too small. If we adapt the two rods of 1gigabytes, the PCs run more working .It can store the more temporary amount of files and data than before. It may be faster for the loading time.
2. The hard disk are IDE and the maximum capacity is 4 GB.
Describing hard disk has 4 gigabytes IDE that is too less storage amount. If we should change 500 gigabytes SATA instead of 4 gigabytes IDE hard disk, it can store more permanent data and faster data transfer then before.
3. The PCs are equipped with just floppy drives.
Now, floppy drives are not widely used, floppy disc can be store 1.44 megabytes, it can't copy the strength of a single MP3 song because the storage amount is too less. If we should change DVD-R/W .It can be burn more data, file, music, video, picture.
4. The PCs have only serial and parallel ports with no USB or Firewire ports.
The mother board had been changed with Pentium 4 mother board together with USB port and fire wire port. But, if the mother board is low model, it can't include fire wire port. Now a day, USB devices are widely used.
5. There is a single low speed dot-matrix printer, shared by all of the PCs, which is out of order most of the time.
Today, dot-matrix printer are not widely used because if print out with dot-matrix printer, the print out color is fade and noisy. Most of Dot-matrix printers are usually used in Super Markets. Instead of using dot-matrix printer with Laser printer, the performance is likely to be more good. If photos are print-out with laser printer, the photos are clear and fine as original photos, but it is too cost.
6. They currently have no network.
If you can use more computer from room to room, you will need connect network .They have two way of connection to network, with wire and wireless .The wireless connection is too much expensive.
7. There is a single dial-up internet connection shared by all the users who need to reserve it in advance.
As the internet connection is with single dialup connection, the usage of internet should be too slow. Of design to use best connection , used ADSL Connection ,but Expensive.

Today's USB

Today, high-speed USB 2.0 offers greater performance increase of up to 40 times faster than USB 1.0), and design data of up to 480 (megabytes per second bit rate Mbps. In the other USB On - The - Go's (OTG) interface, a supplement to the USB 2.0 specification was established in 2002. USB OTG defines a dual role of the device can serve as a host or peripheral use, and connect to a computer or other portable devices to connect through the same connector. Such as handheld computers, mobile phones and digital cameras and other portable computing devices to serve as a fact of the PC advantage of USB peripheral devices, and more connection to connect to other USB devices connected to a direct connection. For example, a user can perform, such as sending photos from your digital camera printers, handheld computers, mobile phones, or send music files to a portable MP3 player to another player, PDA or mobile phone business.

The computers have the main memory capacity of 64MB and speed of (223) MHZ. Low memory speed and capacity can cause delay of works for the students, So I suggested their school management to upgrade the memory with two rods of 1gigabytes and speed 667 MHZ As the capacity of IDE Hard disks of all Personal Computer in school have 4 GB, it drive slowly and faced problems in storage of data. So I suggested to their school management to upgrade with 500 GB (SATA) hard disk drive. Moreover, the Windows XP model should be used instead of windows ME, so I suggested to their school management to upgrade with Window Vista. When I finished the suggesting for school's computer system, I surf the internet to retain the computer hardware prize and brand. And then I chose the hardware components to suitable with schools and convenient for the students. All the task took about 1 week to finish.

Task (2)

I search the data from the internet and write.

Task (4)

I read from FHOS book and windows software. I install window virtual and then I get print screen.

Task (5)

I read Printer problems and troubleshooting manual book and search from internet

Task (6)

I make Windows XP Service Park2 now.

There is two methods for installation this Windows.

First method, open my computer. Then I insert the Window XP installation CD.

When I insert this CD, Welcome to Microsoft Windows XP appears on the monitor screen.

But this method has little problems. If I use this method, I must have old windows.

So, the hard disk that I use is new or it is formatted this method can't use. So, I don't use this method. So, I use second method.

So, I press Exit button. I use method that my computer is restarted from start and Boot Sequence is started from CD ROM. So, I restart my computer. When my computer is open, I press Delete key to enter the Bios features. Then, I enter the BIOS FEATURES SETUP. Then, I place CD ROM at first boot device. And, Hard disk drives at second boot device. After that, I press Yes at Save and Exit Setup.
Windows XP Professional Setup(
1. To set up windows XP now, press ENTER

2. To repair a windows XP installation using Recovery Console, press R

3. To quit Setup without installing Windows XP, press F3 is appeared on the screen

1. To repair the selected Windows XP installation, press R.

2. To continue installing a fresh copy of Windows XP without repairing, press Enter is appeared.
No.1 is used when I have old window. I must make new Window. So, I press Enter button.

Next state is
1. To set up Windows XP on the selected item, press ENTER.

2. To create a partition in the unpartitioned space, press C.

3. To delete the selected partition, press D.
Then, I press ENTER on the Window partition.

Next state is
4. To continue Setup using this partition, press C.

5. To select a different partition, press Esc.
The next state that is to format the Window.
6. Format the partition using the NIFS file System(Quick)

7. Format the partition using the FAT file System(Quick)

8. Format the partition using the NTFS file System

9. Format the partition using the FAT file system

10. Leave the current file system intact(No changes)
User Manual

Printer problems and troubleshooting
I'm going to explain about printer problems and how to troubleshoot.

There are many printer problems. Firstly I going to explain the problem that the layout of page looks wrong when print it. You may be printing a document that was created with a different language version of Microsoft Word and formatted for a different paper size. To have Word format the document to your printer's paper size for this printing session only, click Print on the File menu. Under Zoom, select the paper size you want to use in the Scale to paper size box. Word will scale the page to fit the paper size you choose, similar to the reduce/enlarge feature on a photocopy machine.

Another problem is that the printer asks you the paper size and you don't have. You may be printing a document that was created with a different language version of Microsoft Word and formatted for a different paper size. To have Word format the document to your printer's paper size for this printing session only, click Print on the File menu. Under Zoom, select the paper size you want to use in the Scale to paper size box. Word will scale the page to fit the paper size you choose, similar to the reduce/enlarge feature on a photocopy machine. If the document was originally created for A4 paper size and you are printing Letter size, or vice versa, you can also specify that Word always scales your documents properly. On the Tools menu, click Options, and then click the Print tab. Then select the Allow A4/Letter paper resizing check box.

Well, I'm going to describe the general printer troubleshooting.
General printer troubleshooting
11. Make sure the printer has power and is on-line. If you are using a manual printer sharing device, make sure the switch is set to activate the correct printer.

12. Turn it off and on again to reinitialize any internal settings that may have gone astray.

13. Use the printer's own self-test, according to the manufacturer's recommendation. If it fails, you have verified that the problem is within the printer. If the print head is not moving at all, the transport motor may have failed.

14. If the printer passes the self-test, try a test print using the Print Screen capability within DOS. If the Print Screen fails, you know the problem is in the relationship between the printer and the computer. Inspect the cable and the cable connections. Replacing the cable with a known good cable is worth trying since cables are so frequently the source of printer problems. Cables can fail with broken wires, loose or broken pins, or incorrect pin-outs.

15. The message "out of paper" is sometimes erroneously reported when there is plenty of paper, and can indicate a physical problem with the printer.

16. If the Print Screen succeeds, the problem may be with your application or its configuration. For example, your application may be set up to direct output to a

17. File instead of the printer, or you might be directing the output to the wrong communications port.
Now I'm going to describe about paper jams
Paper Jams
A paper jam occurs if a sheet of paper gets caught in, or refuses to pass through, the printer mechanism. A paper jam may be caused by paper which is too heavy or too light for the printer, or by damp paper, however many paper jams happen for no apparent reason when using the correct paper.

If a paper jam occurs, carefully follow the procedures in the laser printer user guide to remove the jammed paper. Pay particular attention to instructions which require the paper to be removed in a specific direction, as the paper may have loose toner on it which has not been fused and which may contaminate the printer mechanism. Paper may also be jammed between paper feed rollers or in the fuser rollers, attempting to pull paper in the wrong direction through these rollers will probably tear the paper.

Always remove jammed paper slowly, do not snatch the paper from the printer mechanism, or pull fiercely, as the paper may tear. When a sheet of paper has been retrieved from the printer, examine it to ensure that the whole sheet has been removed, if a small fragment remains in the printer it will probably cause another paper jam.

If repeated paper jams occur there is probably an obstruction in the paper path, the most likely cause is a small fragment of paper left by another paper jam.

Well, I stop my presentation here. Thank you very much.
5 essential windows Utilities
Disk Cleanup

If you use the Disk clean up, it can erase the free space of HDD and you use it many times to run your computer fast.

Disk Defragment

If you use Disk Defragment, it can solve file fragmented files, contiguous files, unmovable files, free space. It many times to run your computer may be fast.

DVD Rom

If your computer is entered viruses, it deleted windows. So, your computer must reboot the operating system. When reboot the operating system, it need DVD ROM. So, DVD ROM is necessary needed.

Note pad

Note pad is essential software because it is not installed that contain windows program.

Calculator

Calculator is easy for used. It contain windows program and it is essential.

Wireless Internet - advantages and disadvantages Since World War II wireless Internet access on the Internet using one life, is very popular part of students and professionals. It is an Internet connection, and wireless Internet in this way various types. For example there wireless Internet access, global mobile communications, or more accurate, personal communication mobile Wi - fi, amplifier system for the development, various types of fixed wireless data and WLAN. WiFi uses radio signals to transmit data between computers, while the GSM mobile phone use. Wireless Internet has its advantages, there are some gaps. Taken, and professionals and wireless Internet is bad check.

The benefits of wireless Internet --

The main advantage of wireless networks is that it helps prevent cable idiot son. Another possibility, the main advantage in this regard is that the best use of Internet and data communications or overseas in the second half to send simple means. Wireless Internet access for one big advantage is that you easily move from place to effectively use the Internet to any location to check on the time, everywhere can. Wireless Internet shortcomings Wireless Internet is the main fault that this is slow compared to other networks. Another important factor is the impact of Wi-Fi connection, a "multi-path influence. The number of signals sent to your antenna was made in a single source. Affect the power of the house, will not give desired results. Wireless connection and return a safe, Internet connection, because anyone breaking a signal, one can also lose your important data safe. Wireless Internet access using the other benefits, more risk factors was included. With a wireless Internet access, you should ensure that your network security so that others do not connect to network.

